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Software Features
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 Easy to use software to create pneumatic diagrams for 

communication with customers

 For free

 No CAD license needed

 Windows look & feel

 Easy to use

 Download from internet

 Languages: de, en 

 Documentation: Online help and PDF

 Operating systems: Windows 7
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Desktop (Windows look & feel)
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 Main menu and toolbars 

 Tool- and document windows

 Online help

 Options dialog

 AboutBox

Scheme Editor - Features
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Tool- and Document Windows
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Library

Model Explorer

Sheet
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Model Explorer
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 Working with multiple sheets

 Drag & Drop mechanism
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Library
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 All symbols of pneumatics

 Create your own libraries

 Most recently used symbols

 Overview of all symbols used

 Integrated search

Scheme Editor - Features

7



Sheet
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 Represents the pneumatic diagram
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Drag & Drop
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 Symbols can per Drag & Drop be placed on sheet or in model 

explorer. 

 Via multi selection, multiple symbols can be inserted with one Drag & 

Drop step.
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Connections
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 With very few mouse clicks symbols can be inserted from the 

library and be connected to a complete pneumatic diagram.
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10



 Show / hide, e.g. port index

 Rotate symbols

in 15 degree steps

 Align symbols to grid, that the ports get aligned

Additional Features
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Search for Symbols
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 In the library

 Symbol Name

 Symbol Designation 

 Material Number

 Material Designation

Scheme Editor - Features
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Search for Accessories
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 All products without pneumatic symbol, e.g. fittings, brakets

 Search via material number (or part of it), or description

 Open accessories search dialog via properties dialog

Scheme Editor - Features
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Accessories in the library

 Accessories in the libraries

 List all accessories

 Filter the accessories

 Set the quantity
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Properties dialog
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 Selection of material number and description

(can also be edited manually)

 Edit position number and/or identification code 
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Properties dialog
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 Insert/add hyperlink 

e.g. to PDF data sheet or to online catalog 
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Parts List
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 with position- and material numbers

 with accessories

 can be printed

 can be exported or be copied into other applications

Scheme Editor - Features

Print Preview
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Title Block
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 Title Block administation

 dwg import is possible

Scheme Editor - Features
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Text
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 Text and text field including formatting

 With this entry fields or dialogs for title blocks can be created 

Scheme Editor - Features
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Graphical Elements
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 Graphical elements (circle, square, lines) inlcuding formatting

 Possibility to draw aggregate lines

Scheme Editor - Features
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Import into Sheet / Export from Sheet
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 Import / Export functions for numerous of data formats

 CAD Formats: dxf, dwg

 PDF for documentation purposes

 Image formats: jpg, tif,  usw. 

Scheme Editor - Features
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Call of External Programs

 Configurable menu, for executing external programs

 The links to the online catalog and the startpage of the calculation 

programs are included by default.
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EMail addresses for support / bugreport
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 support.dnc-scheme-editor@boschrexroth.de

Scheme Editor - Features
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New Features in Version 3

 Air Consumption (up to Version 5.2)

 Sheet Formats added

 Interface from Product Catalog to D&C Scheme Editor

 Search for Symbols

 Graphical Elements added

D&C Scheme Editor – New Features Version 3
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Air Consumption (up to Version 5.2)

 For the component type

cylinder the amount of air

consumption is calculated

with user-modified 

parameters and 

user-created flow chart

D&C Scheme Editor – New Features Version 3
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Sheet Formats added

 The default sheet format

can be set via options

 For each sheet, the format

can be changed subsequently

via File ► Setup Sheet

 Title Block formats are 

available from ISO A1 to 

ISO A4

D&C Scheme Editor – New Features Version 3
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Interface from Product Catalog to D&C Scheme Editor

 Symbols or material numbers are assigned directly from the product 

catalog into the D&C Scheme Editor

 From search result, the symbol can be inserted into the sheet directly 

via drag & drop

 While material number’s handover, the material number and the 

designation are assumed

D&C Scheme Editor – New Features Version 3
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Search for Symbols

 Included search item history

in the search dialog

 If a search result is transferred into 

a sheet, it’s material number and 

designation are assumed into the 

properties

D&C Scheme Editor – New Features Version 3
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Graphical Elements added

 Elliptical arc

 Elliptical sector

D&C Scheme Editor – New Features Version 3
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New Features in Version 4

 User Defined Fields

 Row and Column Configuration in Parts List

 ICS Configurator

 Print all / Publish as PDF

 Context-sensitive Help

 Library Layout

 Insert Graphic

D&C Scheme Editor – New Features Version 4

30



02/2016 | DC/ENE22 | © Bosch Rexroth AG 2015. All rights reserved, also regarding any disposal, exploitation, reproduction, editing, distribution, as well as in the 

event of applications for industrial property rights.

User Defined Fields

 30 user defined fields per model

 Can be edited individually for each model

 Predefined set for new models can be defined in the options dialog

D&C Scheme Editor – New Features Version 4
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User Defined Fields

 With user definied fields it is possible to set individual informations to 

the symbols

 This information is visible in the parts list

D&C Scheme Editor – New Features Version 4
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Row and Column Configuration in Parts List

 Order, visibility and width for parts list columns can be configured

D&C Scheme Editor – New Features Version 4

33



02/2016 | DC/ENE22 | © Bosch Rexroth AG 2015. All rights reserved, also regarding any disposal, exploitation, reproduction, editing, distribution, as well as in the 

event of applications for industrial property rights.

Row and Column Configuration in Parts List

 Visibility of rows can be configured and applied through a filter

 Accumulation of symbols with the same material number and 

designation can be switched on and off

D&C Scheme Editor – New Features Version 4
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ICS Configurator

02/2016 | DC/ENE22 | © Bosch Rexroth AG 2015. All rights reserved, also regarding any disposal, exploitation, reproduction, editing, distribution, as well as in the 

event of applications for industrial property rights.

 Circuit diagrams for valve terminal systems, maintenance units and 

so other systems composed with the ICS Configurator can be 

transferred to D&C Scheme Editor

D&C Scheme Editor – New Features Version 4
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ICS Configurator

 Transfer from ICS Configurator is similar to transfer componentens 

from product catalog

D&C Scheme Editor – New Features Version 4
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Print All / Publish as PDF

 All sheets of a model can be printed or published as PDF at once

D&C Scheme Editor – New Features Version 4
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Context-sensitive Help

 For the active window it’s possible to show the context-sensitive 

online help with F1

 Sample:

D&C Scheme Editor – New Features Version 4
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Library Layout

 The arrangement of the library elements and the preview size of the 

icons can be set through the options

D&C Scheme Editor – New Features Version 4
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Insert Graphic
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 In addition to the clipboart it’s possible to insert images with 

menuitem Insert ► Graphics... and a file selection dialog

D&C Scheme Editor – New Features Version 4
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New Features in Version 5

 Generate new Symbols with Rexroth Symbol Modeling Tool (SMT)

 User Library to generate own libraries (up to Version 6)

 Change Connection Line Type 

 Create new Connection Line Types

 Change Element Order in Model Explorer

 Publish as PDF / Print Air Consumption (up to Version 5.2)

D&C Scheme Editor – New Features Version 5
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Rexroth Symbol Modeling Tool (SMT)

 Modify existing symbols.

D&C Scheme Editor – New Features Version 5
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Rexroth Symbol Modeling Tool (SMT)

 Create new symbols and insert ports.

D&C Scheme Editor – New Features Version 5
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Rexroth Symbol Modeling Tool (SMT)

 Create new symbols from models 

via Copy&Paste.

D&C Scheme Editor – New Features Version 5
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Rexroth Symbol Modeling Tool (SMT)

D&C Scheme Editor – New Features Version 5

 Use new or modified symbols in D&C Scheme Editor.
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 Rearrange symbols with 

Drag&Drop in user library.

 Create individual folder structure.
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User Library (up to Version 6)

D&C Scheme Editor – New Features Version 5

46



02/2016 | DC/ENE22 | © Bosch Rexroth AG 2015. All rights reserved, also regarding any disposal, exploitation, reproduction, editing, distribution, as well as in the 

event of applications for industrial property rights.

User Library (up to Version 6)

 Transfer parameterized symbols to user library via context menu. 

D&C Scheme Editor – New Features Version 5
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User Library (up to Version 6)

 Exchange user libraries via export / import.

D&C Scheme Editor – New Features Version 5

User BUser A
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Change Connection Line Type 

 To assign predefined line types use properties (direct or “Format”

dialog) or use button “Line Type” in toolbar “Format” .

D&C Scheme Editor – New Features Version 5
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Create new Connection Line Types

 To create, edit and delete line types use “Tools -> Options -> Line 

Types”.

 The format settings for a new connection line are defined in the 

 “Default Settings”.

D&C Scheme Editor – New Features Version 5

50



02/2016 | DC/ENE22 | © Bosch Rexroth AG 2015. All rights reserved, also regarding any disposal, exploitation, reproduction, editing, distribution, as well as in the 

event of applications for industrial property rights.

Create new Connection Line Types

 To format a connection line use buttons “Line Color”, “Line Width” 

and “Dash Style” in toolbar “Format”  or use properties.  

D&C Scheme Editor – New Features Version 5
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Change Element Order in Model Explorer

 The order of models, sheets and symbols can be canged by 

Drag&Drop or buttons in the toolbar.

D&C Scheme Editor – New Features Version 5
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Publish as PDF / Print Air Consumption

D&C Scheme Editor – New Features Version 5
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New Features 5.2

D&C Scheme Editor – New Features Version 5.2

 The Air Consumption has been completely removed.

Use the online version if required.
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Scheme Editor – New Features Version 6

New Features 6

Scheme Editor 6.0

 New library

 New search

 New accessory handling

Symbol Modeling Tool 2 

 Add a material number list to a Symbol
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Scheme Editor – New Features Version 6

New library

Library management

Search mask

Symbol preview,

or search results,

or accessories

Standard and user library were merged. The search and search results were integrated. The appearance 

of accessories was also changed.
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Scheme Editor – New Features Version 6

New library

Read-only

Libraries can be read-only or editable. In read-only mode libraries can not be modified. 

In editable mode the structure, the symbols and the accessories can be changed.

Editable
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New Search
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Scheme Editor – New Features Version 6

Search results

Search in 

„All libraries“, 

for all symbol names 

which include „a2“ .

Symbols can be searched by the symbol name, symbol designation, the material number or the material 

designation. The location can be restricted to "All libraries", "Selected library" or "Selected library folder".
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New Search
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Scheme Editor – New Features Version 6

Search results

Symbols can be searched by the symbol name, symbol designation, the material number or the material 

designation. The location can be restricted to "All libraries", "Selected library" or "Selected library folder".

Search in 

„All libraries“, 

for all material 

numbers which 

include

„864“
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New Accessory Handling
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Scheme Editor – New Features Version 6

List of all accessories

Accessories folder

All accessory items are listed. The accessories can be edited.

Prepare quantity of accessories

before Drag&Drop

Filter accessoriesEdit accessories
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New Accessory Handling
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Scheme Editor – New Features Version 6

Add accessories,

Delete …

New accessories can be added. Existing elements can be edited or deleted.
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New Accessory Handling
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Scheme Editor – New Features Version 6

A linked accessory can be changed later.
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Scheme Editor – New Features Version 6

Symbol Modeling Tool 2

 Add a material number list to a Symbol
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Scheme Editor – New Features Version 6.1

New Features 6.1

Scheme Editor 6.1

 New feature to transfer libraries of previous version after update

 Bug fixes

Symbol Modeling Tool 2.1 

 Symbol name now can contain ‘-‘ as valid character

 Bug fixes
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Scheme Editor – New Features Version 6.1

Import Libraries of Previous Version

 Libraries of the previous version (starting with libraries of Scheme

Editor 6) can be transfered into the updated version
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Scheme Editor  – New Features Version 6.2

New Features 6.2

Rexroth Hydraulic Library

~ 1500 symbols

~ 70.000 material numbers

Set of scheme symbols for quick schemes
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Scheme Editor  – New Features Version 6.3

New Features 6.3

Extended Rexroth Hydraulic 1.1 Library

Set of scheme symbols for quick schemes
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